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1. Introduction

Welcome
Welcome to the Em5 data collection system. The Em5 is
designed to provide you a convenient, high-quality data
collection system at a relatively low cost. This manual will
explain the Em5’s capabilities and functions.

Contact Information
To contact Decagon for customer support or questions:

• Email us at em5@decagon.com

• Send us a fax at: (509) 332-5158

• Call us at: 1-800-755-2751 (US and Canada only) 
or 509-332-2756.

Warranty Information
The Em5 has a 30-day satisfaction guarantee and a one-
year warranty.

Seller’s Liability
Seller warrants new equipment of its own manufacture
against defective workmanship and materials for a period
of one year from date of receipt of equipment (the results
of ordinary wear and tear, neglect, misuse, accident and
excessive deterioration due to corrosion from any cause
are not to be considered a defect); but Seller’s liability for
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defective parts shall in no event exceed the furnishing of
replacement parts F.O.B. the factory where originally man-
ufactured. Material and equipment covered hereby which
is not manufactured by Seller shall be covered only by the
warranty of its manufacturer. Seller shall not be liable to
Buyer for loss, damage or injuries to persons (including
death), or to property or things of whatsoever kind
(including, but not without limitation, loss of anticipated
profits), occasioned by or arising out of the installation,
operation, use, misuse, nonuse, repair, or replacement of
said material and equipment, or out of the use of any
method or process for which the same may be employed.
The use of this equipment constitutes Buyer’s acceptance
of the terms set forth in this warranty. There are no under-
standings, representations, or warranties of any kind,
express, implied, statutory or otherwise (including, but
without limitation, the implied warranties of merchantabil-
ity and fitness for a particular purpose), not expressly set
forth herein.

FCC Compliance (for the Em5R and
Rm1)
This device complies with part 15 of the FCC Rules.
Operation is subject to the following conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received,
including interference that may cause undesired opera-
tion.
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2. The Em5

About the Em5
The Em5 is a 5-channel, self-contained data logger with
an optional radio telemetry module (Em5R). It is housed
in a white weather-resistant  enclosure, making it suitable
for long-term outdoor operation. It is powered by 4 AAA-
size alkaline batteries. Without the radio, a set of batteries
can last for several years. With the radio operating in
“broadcast” mode (model Em5R only), the batteries
should last over a year, and in “query” mode they should
last for about 1 month.

The Em5 setup
An Em5 system consists of the Em5 module, sensors,
data collection apparatus (such as a computer or hand-
held PC), and EchoLink computer interface software
(included with Em5). The only sensors that will attach to
the Em5 are ones built specifically for the system by Deca-
gon. The sensors plug into the Em5’s 5 channels and then
take measurements according to your programmed sam-
pling interval. The Em5 itself comes in two versions: one
with radio capability (Em5R) and one without (Em5). The
Em5R has a radio module installed that allows it to com-
municate telemetrically (once properly configured) with an
Rm1 radio modem, which, in turn, connects to a com-
puter. One Rm1 is capable of collecting data from multi-
ple Em5Rs. 
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In both the non-radio Em5 and the radio-enabled Em5R,
you can download data directly via an RS-232 cable that is
plugged into the first channel (labeled “1” on the under-
side of the base plate) and connected to a computer. The
EchoLink computer interface software allows you to pro-
gram the time, date, and measurement interval times of
the Em5, and download data. The PassiveTerm program
is used in conjunction with the Rm1 as a simple terminal
program that captures data as it is transmitted and allows
it to be stored.

Em5 data logging scheme
Before collecting data with your Em5, you should set the
measurement interval with EchoLink (see Chapter 4).
This measurement interval controls how often data is
recorded in the Em5's internal data storage. The interval
you choose applies to all 5 ports on the Em5. It is not pos-
sible to have one port measuring sensors more or less fre-
quently than another port. For most applications, a
measurement interval of 60 or 120 minutes is appropriate.

The measurement interval works relative to the Em5's
internal real-time, 24-hour clock. For example, when
choosing a measurement interval of 120 minutes, the Em5
will store data every two hours, on the hour. The resulting
data will show sensor measurements hourly at 12:00 am,
2:00 am, ..., 10:00 pm. Choosing a measurement interval
greater than 720 results in one set of data stored per day.

For most sensor types, the Em5 makes a measurement
from each of the 5 sensor ports every 60-seconds —
regardless of the measurement interval value. When the
Em5’s internal clock reaches the time to store a reading,
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the average value of all the 60-second sensor readings is
stored. Therefore, if you set the measurement interval to
60, the Em5 will actually store an average of the past 60
sensor readings. If you choose an interval of 1440, the
Em5 will store one value that represents the average sen-
sor value for the entire 24-hour period.

For ECHO Rain Gauges, the value stored at the wake
interval is the total tip events within the interval.

The Em5 internal data storage is non-volatile. Loss of bat-
tery power does not erase configuration settings or stored
data.
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3. Set-up and Installation

Installation of the Em5 system involves loading software
on the computer that you plan to use for communicating
with your Em5s, configuring the time, date, and operation
of the Em5s, and installing the Em5s in the field with their
relevant sensors.

Batteries
The Em5s are shipped with a new set of batteries. When
the battery life indicator in EchoLink shows your Em5’s
batteries are less than 5%, you need to replace them. For
information on replacing the batteries, see chapter 5. Note:
The internal data storage of the Em5 is non-volatile, so you will not
lose data if you remove the batteries.

Software
The EchoLink software that was included with your Em5
is a standard Windows application that installs in the typi-
cal fashion. Place the CD in your CD drive, and wait for it
to auto-launch. If it doesn’t launch by itself,  click on the
“setup.exe” file. Then follow the subsequent installation
prompts. Occasionally, new versions of software will
become available on our website. They can be accessed in
the Em5 section of:
www.decagon.com/instruments/agdownload.html

You can find your current software version in the “About”
option of the Help menu in EchoLink. If you are con-
nected to the internet, EchoLink will check to see if there
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is a newer version available. If there is, it will prompt you
to the web page where you can download it

Configuring the Em5
Before field installation, the Em5 logger needs have
parameters such as name, date, time, measurement inter-
val, and communication mode set or defined. Also, the
radio-enabled Em5R will not respond to radio contact
until properly configured to do so. The Em5 can be
directly connected to your computer using the 9-pin to
3.5-mm plug RS-232 cable (included with the logger). To
accomplish this, do the following: 

1. Run the EchoLink program.

2. Plug the 3.5 mm connector of the Rs-232 cable into 
Port 1 of the logger, and plug the 9-pin connector into 
the serial port of your computer. (Note: Make sure 
EchoLink is running before connecting, or data 
loss may occur).

3. Set the correct COM Port address (See page 23) 

4. Use the EchoLink program as described in Chapter 4
of this manual, to set the name, date, time, measure-
ment interval, and radio mode of the logger. The
optional Em5R and Rm1 radio modem may also be
configured for communication (See  Radio Settings)

Installing the Em5
The Em5 will serve as a collection station for up to 5 sen-
sors. The Em5 is compatible only with sensors made by
Decagon specifically for use with the Em5s, such as the
ECH2O water content probes, rain gauge, temperature
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sensors, etc. To install the Em5 and sensors, do the fol-
lowing:

1. Install your probes as directed in the respective sen-
sor’s manual.

2. Plug the sensors’ jacks firmly into the Em5 input
ports. Unused inputs should be plugged to prevent
dirt, water and insects from entering the case. Plugs
are provided for covering unused inputs. Note: the
ECHO Rain gauge should be plugged only into
ports 2 through 5.

3. On each side of the Em5, there are three loop-holes.
Use these to fasten the Em5 to a mounting post using
the included zip-ties or a similar fastener. Make sure it
is installed in an upright position, with the 5 input
ports underneath. In this position, rain and spray are
shed by the enclosure and drip off without affecting
the contents of the Em5 enclosure.

Cautions:
• Do not immerse the Em5.

• Make sure to install the Em5 upright, so that water 
cannot enter the input ports, which can result in 
damage to the logger. 

• Do not install Em5R radio-enabled loggers near 
large metallic objects, as these can attenuate the 
radio signal. 

• If the Em5R is mounted to a metallic post, be sure 
to use an antenna extension cable to mount the 
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antenna to the top of the post. This will maximize 
the transmit range of the Em5R.

• If you are using probes with cables longer than 16 
feet (5m), there is a higher risk of damage to the 
Em5 if hit by lightning.

Range considerations
The range of the radio indicated in the specifications for
the Em5R is the maximum range attainable with standard
antennas and a clear and open path between the transmit-
ter and the receiver. Both transmitter and receiver must be
at an adequate distance above the ground. 

Obstructions will attenuate high frequency radio signals,
such as those from the Em5 radios. The higher the fre-
quency, the greater the attenuation, so the usable range of
the 2.4 GHz radios (available for use in locations outside
the USA) is shorter than that for the 900 MHz units.
Buildings, hills, vegetation, vehicles and other obstructions
will shorten the radio's range — sometimes drastically so.
Also, radio frequency (RF) interference in the environ-
ment around the radio can reduce the usable range. 

You can greatly help the effective transmit range both by
maximizing the height above ground of  the Em5R’s
antenna and by using a directional Yagi antenna. Use our
antenna extension cables to raise the height of the
antenna. Different types of Yagi antennas and extension
cables are available from Decagon. Also, maximizing the
separation from RF sources such as electric motors, trans-
formers, cell-phone towers, and vehicles will also increase
your transmit range
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Sensors
Sensors suitable for use with the Em5 are sold by Deca-
gon. These include the ECH2O soil moisture probe, the
ECHO Rain gauge, temperature sensors, and Drain
Gauge. Other sensors will become available in the future.
The sensor is simply installed and plugged into the logger.
Unused inputs should be plugged. Note: The ECHO
Rain gauge must not be plugged into channel 1 of the
Em5, since it causes conflicts with the internal hard-
ware. Plug this sensor into channels 2 through 5 only.

Radio Settings
For a group of Em5Rs to communicate with a radio
modem (Rm1), both the channel number and the sub-
channel of all units (including the Rm1) must coincide.
Additionally, each Em5 must have a unique name. 

Groups of Em5s with different channel numbers use dif-
ferent frequency-hopping sequences, and therefore experi-
ence minimal interference between groups. 

Groups with the same channel numbers but different sub-
channel numbers can interfere with each other, but can't
communicate with each other. This interference can also
cause additional battery drain.

Typically you pick a channel and a sub-channel, and set all
Em5Rs and the radio modem (Rm1) to these numbers.
Each Em5R is then given a unique name. If groups of
Em5Rs are operating in adjacent fields within range of
each other, and you want to access one group without dis-
turbing the other, the two groups should be set to differ-
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ent channel numbers. If the two groups are being
contacted with the same radio modem (Rm1), the radio
modem channel number needs to be changed to match
each group before the Em5Rs in that group can be con-
tacted. 

The channel and sub-channel numbers are both set
to zero when the radio is shipped from the factory.
These settings may be modified using the EchoLink soft-
ware, as explained in chapter 4.

Setting up the Rm1 Radio Receiver
The Rm1 receiver module is specifically designed for com-
munication between the Em5R (radio-enabled) loggers
and a computer. Typically one Rm1 will serve as the radio
modem for all of your Em5Rs, since it can collect data
from many different Em5Rs. To set up communication
between the Rm1 and the Em5Rs, do the following:

1. Connect the 6-in. antenna to the gold “RPSMA” plug
on the Rm1.

2. Plug the 9-pin RS-232 cable (included with Rm1) into
the RS-232 port on the Rm1, and plug the other end
into an available serial port on your computer. See
page 23 for more information on setting up your
COM port correctly.

3. Plug in the AC adapter that came with your Rm1 and
insert the 5.0 mm plug into the Rm1’s “DC in” jack. If
you want your Rm1 to be mobile, contact Decagon for
information on an adapter that attaches to your car’s
12V output (cigarette lighter).
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4. Move the switch to the “up” position to turn it on. If
the serial port is active, the red LED is steadily illumi-
nated, and blinks when data is being transmitted. The
yellow LED blinks when it receives data.

Note: The standard antenna supplied with the Rm1 
is for indoor use only. Please contact Decagon 
about an all-weather antenna if you choose to use 
your Rm1 outdoors.
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4. Software

The EchoLink program
The EchoLink software provides a user-friendly interface
for configuring, downloading and interrogating the Em5
logger. Note: Do not connect the Em5’s RS232 cable to
your computer until you have the EchoLink program
launched, or data loss may result. To use the program,
first install the EchoLink program from the CD-ROM
that comes with your Em5. Launch the program and you
will see the following screen:

The top right portion of the screen shows different icons
for interacting with the Em5s. To the left is a batter indica-
tor and a radio signal strength indicator (RSSI). Below are
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three tabs: a text field where you will see data displayed as
it is downloaded, a Setup tab that allows you to name and
configure your loggers, and a Terminal tab that allows you
to give direct commands to the logger via a terminal pro-
gram. These functions will be described in detail further in
this chapter.

Getting Started: Configuring the Em5
Before you begin using the Em5, you will need to the 
measurement intervals you want, as well as give it a unique 
station name that you can use to identify it. Follow these 
steps to set up the logger:

1. Set up EchoLink by selecting the Preferences dialog 
from the Edit menu. Select the COM Port you are 
using.

2. Plug the RS-232 cable into port 1 of the Em5 and 
select “Direct Serial” from the Connect via: drop-
down menu at the top of the screen. Connect the 
other end of the cable into the COM port you speci-
fied in step one.

3. Click on the “Connect to Em5” icon on 
the upper right toolbar. A message will 
appear in the lower left corner of the 
screen indicating that it is trying to con-
nect. Once connected, the top of the 
screen will show that it is connected, and the name of 
the Em5 that it is connected to is displayed.
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The Setup Menu

1. Click on the “Setup” tab to configure and set up your 
Em5. The following screen will appear:

Configure your logger using the options listed in this 
menu. Below is a description of the options:

Em5 Name dialog box: Use this to give a unique name 
to your Em5, in order to distinguish it from other Em5s 
you may have. In the example above, this Em5 is named 
“Field01” You can use up to 8 alphanumeric values (no 
spaces) for this name. 

Measurement Interval: Designates the desired time 
interval (in minutes) between reading the sensors con-
nected to the Em5. In this example, readings are pro-
grammed to be made once an hour (every 60 min.).
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Set Time: Press this button to program the Em5 with the 
same time and date as your computer. 

Power Noise Filter: This is used to filter out electro-
magnetic noise caused by the AC electricity supplied by 
your electric utility to your home or office. Select the fre-
quency for your country’s standard (e.g. North America 
and Japan are 60 Hz, Europe and Australia are 50 Hz)

Channel/Sub-Channel: This sets the radio channel and 
sub-channel (for Em5R only).The channel and sub-chan-
nel must be the same for all Em5Rs and Rm1 to commu-
nicate. The Channel setting can be any number from 0 to 
6, and the Sub-Channel setting can be any number from 0 
to 65535. 

Radio Mode: This selects the way the Em5 will transfer 
its stored data, either directly or via telemetry. Here is a  
description of the different modes:

• No radio: The Em5 will take and store measure-
ments as configured, and will only download via 
direct connection with RS-232 and a computer or 
iPAQ-type device.

• Transmit only: After taking and storing each mea-
surement, the Em5R will transmit the reading to a 
“listening” receiver. This mode is the most ideal 
radio mode in saving battery life, however it is 
only useful when the Rm1 or Datastation is avail-
able to receive the data. The actual transmit time is 
randomly delayed to help prevent two or more 
Em5Rs from transmitting at the same time.
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• Communicate from 06:00-18:00: From 6:00 am to 
18:00, the Em5R will  “listen” for any available 
connection with an Rm1 every 45 seconds. If an 
Rm1 is actively transmitting, the Em5R will wait 
for a login command for a short time. This mode 
useful for reducing battery consumption by not 
trying to make radio connections during the night.

• Communicate Always: The Em5R will function as 
described above on a 24-hour basis. 

• Communicate Always and Transmit: Functions as 
described above, but will also transmit data as 
measurements are taken. This mode uses the most 
battery power, and is primarily for troubleshooting 
radio connection problems.

After you have set the desired values for the Em5, click on
the “Apply” button in the lower right button. You are
ready to install the Em5 in the field.

Note: While the Em5 is actively communicating
(either via direct connection or radio), no sensor read-
ings will be collected or stored.

Note for Em5R Communication: When the EchoLink software is
already connected to an Em5R, clicking the “Connect” button again
will cause the radio to log out of the currently active logger and search
for another listening Em5R. If there are others listening, it will con-
nect to one of them immediately. Once logged out, an Em5R will
“sleep” for 10 minutes before being available again for communica-
tions. 
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Downloading Data
Once the Em5 is properly set up and installed, it will begin 
taking and storing measurements. Depending on how you 
have your Em5 or Em5R set up, it will either just store the 
data, or store and transmit the data. To download data, do 
the following:

1. For a direct connection, unplug any probe that may be 
present in channel one of the Em5, and insert the RS-
232 cable. If using an Rm1 to connect to Em5Rs, 
make sure it is connected to your computer’s serial 
port and the COM settings are set correctly.

2. Open EchoLink, choose your connection method 
(direct serial or Rm1 radio) in the “Connection via:” 
dropdown menu, and press the Connect icon:

3. Once connected to an Em5, press either the “Down-
load New Data” icon 

or the “Download All” icon:



Em5 User’s Manual
Software

19

Download: Downloads all data collected
since the last download. The Em5’s name will
appear in the save window as the default file
name. If “append to file” is selected in the

Edit>Preferences menu, clicking “Save” will add the new
data to the current data in the destination file.  which dis-
plays the data as “raw” values. To see the actual down-
loaded data converted to sensor-specific data, you must
export it first. The data can then be exported by EchoLink
for the particular sensors attached (see the “Export” func-
tion in the File menu). The exported files can be imported
by standard spreadsheet programs.

Download All: Downloads all data stored in
the memory of the Em5. The Em5 name will
appear as the default file name.

Disconnect: Logs you out of the current Em5.
After logging out over the radio, the Em5R will
not respond for 10 minutes in order to allow
connections to other Em5R's. Note: When

downloading over a radio connection, be sure to
press “disconnect” as soon as you are finished down-
loading data. EchoLink keeps the remote Em5R
awake waiting for your commands until you dis-
connect. Therefore, leaving EchoLink connected
over the radio will rapidly consue the Em5R bat-
tery life.
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Manual Measurement
If you want to initiate a reading manually (separate from 
the pre-programmed sampling interval) you can do so by 
either pressing the Scan icon 

or by selecting “Scan Ports” from the Actions menu. The 
Em5 will take a measurement on all available ports, then 
display the following screen:

The 5 ports are displayed, along with the raw output val-
ues for each port. If nothing is plugged in, you will see val-
ues similar to the example above. Note: in this example, the 
number “4091” appears in Port 1’s column because port one is 
directly connected to the RS232 cable and therefore has no sensor 
connected. To convert the raw values to the desired units 
specific to the sensor connected to each respective port, 
right-click on the value and a drop-down menu will appear 
with different sensor type options. After selecting a sensor 
type, the data will be displayed in units for that sensor.
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Menus

File Menu

File > Export:
Data downloaded from the Em5 is stored as comma-
delimited, raw numbers. The Export function is used to 
convert these values to recognizable engineering units, 
such as millivolts (mV), water content, temperature, etc. 
From the File menu, select File > Export. Opening the 
Export window will display the following screen: 

Ports 1 through 5 correspond to the 5 input channels on
the Em5. Select the sensor in each Em5 port from the
pull-down menu. If you leave a setting in a port window to
“Default,” it will export the raw numbers. When you
select a sensor type from the menu will change the raw
numbers to the desired sensor measurement (water con-
tent, temperature, mV, etc.) using the factory calibration of
the respective sensors. Sensor selection in each port will
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be reset to Default each time the Export window is
closed. 

Note: Soil-specific calibration for Decagon’s ECH2O water content
probes may differ from the factory calibration in some cases. If this is
the case, use the Default setting to get data in mV and then apply
the specific calibration in a spreadsheet program.

A Source and Destination file must be selected to
export data. The source file is the file specified when the
data logger was downloaded. The destination file is the file
in which you would like to store the exported data. Once
the source and destination files are specified, click
Export. The program will display “Export Complete”
when finished. Click “OK” to return to the Export utility. 

Click on the “Close” button to end an Export session.

Once exported, the data will be arranged in the following
format:
Em5 name, Year, DOY, Time, Sensor 1, Sensor 2, Sensor
3, Sensor 4, and Sensor 5, where DOY is the day of the
year and Time is minutes into a day (e.g. 350=5:50am,
1310= 21:50 (9:50pm)). Data can be split into columns
using a spreadsheet program.

Export will allow you to export multiple files without
closing the Export window. This is especially useful if
there are several Em5 data files with the same sensor input
channel configuration.
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Edit Menu
The Edit Menu contains typical commands for cutting, 
pasting, and selecting data, as well as Preferences for inter-
facing with your Em5.

Edit > Preferences
The Preferences menu gives you several options. It allows
you to select the COM Port you are using, and the number
of  times EchoLink tries a command when connected via
radio. It also allows you to either enable or disable the Ter-
minal tab from the main menu, as well as whether or not
to append new data to the same file when downloading
data from the Em5.

COM Port Settings: When connecting directly to the
Em5 or using the Rm1, the computer will communicate
using one of its communication ports. The default port is
COM 1. Other ports can be selected using the pull-down
menu and selecting the desired port. Warning: Commu-
nication between the computer and Em5/Rm1 will
not occur if the COM port is set improperly.
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Note: PDA desktop communication (“HotSync”)
software that runs in the background of your PC
may interfere with your computer’s ability to com-
municate with the Em5. If you encounter problems
with communication, make sure you close any PDA
synchronization utility that may be running in the
background.

Data Menu
The Data menu has three options: “Download Data,”
“Download New,” or “Erase Em5.” The “Download
Data” option functions the same as clicking on the
“Download All” button from the main menu. This will
download all the data stored in the Em5. Similarly, the
“Download New” option, like the “Download New” but-
ton in the main menu, will only download the newest data
that has been stored since your last download. 

To erase all the data stored in the Em5, select “Erase
Em5.” When you select this option, a dialog box will
appear, warning you that all the data will be erased if you
proceed.

Actions Menu
The first three options in the Actions Menu (Connect,
Disconnect, and Scan Ports) are identical to the buttons
on the main menu. For more details on these items, refer
to the “Downloading Data” section earlier in this chapter.

Device Test
This option checks the integrity of the Em5’s operating 
code. You must first connect directly to the Em5 using the 
RS232 cable before performing this test. If the code is 
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found to be corrupt or damaged, the program will alert 
you. 

Telemetry Test
This option only works when connecting to an Em5R log-
ger via the Rm1 radio modem. This test checks to see how 
well you can receive data from the Em5R at the current 
position and distance, which will give you a better idea of 
any signal attenuation before you proceed to make a per-
manent installation. To perform the Telemetry test you 
must first be connected to an Em5R remotely (through an 
Rm1 Modem).  Note: This test rapidly consumes the 
remote Em5R’s battery power, so be careful in the 
length of time that you take to perform this test.

Reset Device
This option will reset the Em5 to its factory default state. 
Your data will be areased, but your configuration settings 
will be left intact. This is a useful tool if you are experienc-
ing any anomalies or inconsistencies in the operation of 
your Em5. 
Note: Proceeding with the reset will delete all data, so 
make sure any data has been downloaded out of the 
Em5 before initiating a reset.

Initialize Radio
This option initializes, or resets, the Em5R’s radio module. 
This is useful if you suspect problems with the Em5R’s 
radio transmission. 

Set Date/Time
This function works the same way as the “Update Time” 
button in the Setup menu. When you select this action, 
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EchoLink will set the Em5’s time and date to be the same 
as the time and date on your computer.

Rm1 Setup
This option is for setting the channel and sub-channel of 
the Rm1, like you do in the Setup menu for the Em5R. In 
order for the Rm1 to communicate with the Em5Rs in 
your desired network, both the Channel and Sub-channel 
values of the Rm1 and Em5Rs must coincide.

First, connect the Rm1 to the correct COM port on the 
computer using the serial cable provided. Once con-
nected, select “Rm1 Setup” from the Actions menu and 
enter the same Channel and Sub-Channel values as the 
Em5Rs you want to communicate with. To save these set-
tings in the Rm1, select “Apply.” To discard changes and 
return to EchoLink, select "Cancel."

Help Menu
The Help Menu contains “EchoLink Help”, which is an 
HTML-help program that opens in your web browser. It 
has a table of contents with brief explanations of how 
EchoLink works, as well as some basic setup instructions 
and troubleshooting guides.

Check for Updates
This option is useful in determining if you have the newest 
available version of EchoLink. If you are connected to the 
internet, EchoLink will check to see if there is a newer ver-
sion available. If there is, it will prompt you to the web 
page where you can download it.
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About
The About option tells you information about the
EchoLink program, including the current software ver-
sion. When you select the “About” in the Help menu, the
following screen will appear, showing the current version
of software:
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5. Maintenance

If installed correctly, the Em5 requires little maintenance.
The main requirement is that batteries need to be replaced
when their charge becomes too low. The Em5s are
shipped with a new set of batteries. We strongly suggest
you use high-performance alkaline batteries when possi-
ble, in order to maximize the life of your Em5. When the
battery life indicator in EchoLink shows your Em5’s bat-
teries are less than 5%, you need to replace them.

To change the batteries, do the following: 

1. Unplug sensors from the Em5.

2. Disengage the tabs on each side of the bottom plate,
and pry the bottom out of the case. 

3. Slide the logger and batteries out of the case. Replace
the batteries, making sure to install them with the
proper polarity. 

4. IMPORTANT: Once the new batteries are
installed, press the silver reset button on the
battery side of the Em5 board to make sure it
starts up properly.

5. During the time that the batteries are being changed,
all current settings and data will be saved, but readings
will not be taken. 

6. The Em5 clock is not saved when changing the batter-
ies. Therefore, after changing the batteries, connect to
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the logger with EchoLink and push the “update time”
button to set the time correctly.

7. When sliding the Em5 assembly back into the case,
take care that it is oriented correctly.

Removing the Radio Module
The Em5R comes with the radio module pre-installed on 
the data logger board. Should you need to remove it for 
any reason, always disconnect at least one battery from 
each of the two battery holders. This will power down the 
radio and avoid any damage. 

Note: Removing the radio module from the data log-
ger can cause the radio module to “freeze” and stop 
functioning properly. After the radio is replaced, press 
the silver reset button on the battery side of the data 
logger board.
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Appendix A

Operation using Terminal
The Em5 can be accessed directly with using the “Termi-
nal” screen in EchoLink or terminal software like Windows 
Hyperterminal for special applications. Following are 
instructions on how to operate the Em5 using terminal 
commands. 

Commands

To directly initiate communications with an Em5 using an
RS232, connect the data logger to the computer COM
port using the Em5 serial cable, and look for the Em5 to
return a “>” on screen. If it does not, check the RS-232
connection between the Em5 and computer, as well as the
COM port settings. 

To initiate communications with an Em5R using an Rm1,
make sure the Rm1 is operating and connected correctly
to your computer, and is set to the same channel and sub-
channel values as the Em5R you are trying to communi-
cate with. In the terminal mode, you will need to send a
“wake-up” signal to the Em5R. This is done by holding
down the “Enter” or the “w” key on your keyboard for
about 50 seconds. Note: Before doing this, change your
keyboard repeat rate to “maximum” in the Keyboard sec-
tion of your computer’s Control Panel. After the 50-sec-
ond “wake-up” command, type “query” to determine
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which Em5R has responded. The name of the first Em5R
to respond will appear on the screen. To log in to that par-
ticular Em5R in order to download and give further com-
mands, press the Enter key and then type “login name”
(where name is the name returned by the Em5R). Once
you log in to the Em5R, a “>” will appear on screen. If it
does not, check the computer and COM port settings. If
you want to log in to a different Em5R, log in to the cur-
rent Em5R, type “logout” and then type “query” again.
Repeat this process until you have connected to the
desired Em5R.

Once you have established communications, you can use
the following list of available commands:

time show time and date
scan show input voltages
show show system data
volt show battery voltage (mv)
dump [-a] dumps new data stored in memory

-a all data in memory
erase erases data from memory
logout quit communicating 

   (radio off for 10 min)
set -t hh:mm sets time (sec = 0 on enter)
set -d yy-mm-dd sets date
set -i ##### sets Em5 name (1..8 characters)
set -w #### sets measurement interval 

   in minutes (1..1440) 
set -r ## sets radio mode

0 = no radio 
1 = transmit only
2= 6am-6pm communication;
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3 = communicate always;
4= communicate always and transmit

time
Shows the Em5’s current time and date.

scan
Allows you to take a direct reading of the input voltages
on all channels. Values shown on screen are in raw units.
Multiply by 0.61 to get mV value. Note: When the Em5 is
connected to the computer with a serial cable, the reading on channel
1 will be the RS-232 voltage.

show
Shows the system data, such as the operating system name
and version, station identification, and current measure-
ment and radio settings. Following is an example:

Decagon Flash Operating System, by
Warren D. Greenway Copyright 2003, All
rights reserved. 

ID: field1 Version: 1.83
Radio: 1 Wake:60 Resets: 0

volt
Shows the current voltage of your Em5, in millivolts. A
fully charged set of batteries should show a voltage of
about 3000mV. When the battery voltage reaches 2700mV,
the batteries must be changed.

dump [-a]
“dump” downloads all new data collected since the last
download. 
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“dump -a” will download all data in the Em5’s memory. 

Data output from the Em5 is in a comma-delimited for-
mat. The data can be saved to a file. In the comma-delim-
ited format, MS Excel and other spreadsheet programs
will recognize each data point in a line separated by a
comma as a new column. Note: The Em5’s station name will
not be displayed on the front of each line in this mode. This features
is only found in the EchoLink software. The columns are
labeled as follows:

Column 1: Days since Jan. 1, 2000; e.g. Feb 4, 2002 would
be "765" (2 years = 730 plus 35 days)
Column 2: Minutes into a day; e.g. 13:30, or 1:30 pm,
would be "810" (13 hours = 780 plus 30 minutes)
Columns 3 to 7: Raw numbers from the Em5’s Analog to
Digital Converter (ADC). The Em5 stores data in raw
ADC numbers. These values can be easily converted into
mV values by multiplying by 0.61. 
Column 8 (Radio Mode 1 only): Em5 battery voltage, in %
of capacity. When the voltage is below 2530 mV, batteries
should be changed.

erase
Erases all data from the Em5’s memory.

logout
Logs out from the current Em5. When connected over
the Rm1 radio receiver module, the logout command will
cause the Em5 to sleep (not respond to commands over
the radio) for 10 minutes.
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set -t 
Sets the time. To set the time, type “set -t ” followed by
the time (e.g.: set -t 14:30). Time must be in 24-hour (a.k.a.
military) format. The dash in front of the t is necessary, as
is the colon separator between hours and minutes.

set -d 
Sets the date. To set the date, type “set -d” followed by the
date in year-month-day format (e.g.: set -d 2002-05-23).
The dash between numbers is necessary.

set -i ####
Sets the name for an Em5. To find its current name, type
“show.” You should then see an id appear on the screen
along with other information. To rename it, type “set i -
XXXXXXXX” (where the X’s are the desired name). The
Em5 can have any alphanumeric name of up to 8 charac-
ters (no spaces). All Em5R radios within talking distance
of each other must have unique names to prevent interfer-
ence with each other when they communicate with the
Rm1 radio receiver. Note: Station names are case-sensitive.

set -w
Set the measurement interval (number of minutes between
each measurement). Valid values are 0 to 1440 (1 day). If
the interval is set to zero, no reading is recorded. For mea-
surement intervals longer than 1 minute, the stored values
are the average of readings taken at 1 minute intervals. For
example, if the measurement interval is set to 60, one set
of readings is recorded each hour with each value being
the average of 60 readings taken during that hour.

set -r



Em5 User’s Manual
Appendix A

35

Sets the radio mode. If you don't have the radio option
(Em5R), set this to 0 (no radio) by typing “set -r 0”. In this
mode (0), battery life is about 4 years. If you have an
Em5R (radio-capable logger), there are three settings
available: 1 (transmit only), 2 (transmit/receive from 6am -
6pm), and 3 (transmit/receive 24 hours/day). The first
option (transmit only) sets the Em5 to transmit its data to
an Rm1 every time a measurement is made. There is a
built-in random delay between the measurement time and
the transmit time so that several Em5’s can transmit to a
single radio modem without interference. If you transmit a
reading once per hour, battery life in this mode should be
over 1 year. 

Modes 2 and 3 are for contacting the Em5Rs and dump-
ing the data using a computer and the Rm1 radio receiver
module. In these modes, the Em5 “wakes” for 150 milli-
seconds every 45 seconds to listen for a signal. If a signal
is detected, it stays “awake” for 60 seconds to await com-
mands. Once an Em5R has responded to the Rm1, any of
the commands listed above can be sent. To close the ses-
sion, type logout, after which the Em5 will be inactive for
10 minutes (to allow other radios within range to be inter-
rogated). These modes require the most power. In mode 3
(activated 24 hours a day), battery life is about 1 month.
Mode 2 (no operation from 6:00 pm to 6:00 am) is often
more preferable, since most users do not need to contact
the logger at night. Therefore, this mode should result in a
battery life of around 2 months.
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Appendix B

Em5 Specifications
Input Channels: 5, with 12-bit A/D resolution and 2.5V
excitation on each channel. 3.5mm “stereo-plug” style
connector.

Data Storage: 49KB (145 days @ 1 scan/hour)

Memory Storage: Non-Volatile Flash Data

Communication:
• RS-232 capability on Port 1

• Optional 900MHz or 2.4GHz spread spectrum 
RF communication (model Em5R); up to 5-mile 
line of sight range with 900Mhz model, 1.5 mile 
line of sight range with 2.4Ghz model.

Power Requirements: 4 AAA alkaline batteries

Enclosure: Weatherproof, impact-resistant NEMA 3R 

Operating Environment: 
-10°C to 50 °C, up to 100% RH

Dimensions: 
8.7cm Length x 6.2cm Height x 3.5cm Width
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Rm1 Receiver Specifications

Frequency-hopping Spread-spectrum Radio:
North America: 902-928MHz ISM
Australia and Israel: 915-928 MHz
Worldwide: 2.4GHz ISM

Serial Data Interface: RS-232

Supply Voltage: 7-18 VDC (AC Adapter supplied)

Current Consumption: 70-210mA

Dimensions: 7.9cm x 13.9cm x 3.8

Weight: 6.9 oz. (195.6g)

Operating Environment: 0 - 70 °C, 10-90% RH

FCC info:
The Em5R and Rm1 (900MHz) contain transmitter mod-
ule FCC ID:OUR9XSTREAM. The 2.4GHz Em5R and 
Rm1 contain transmitter module FCC 
ID:OUR24XSTREAM. These devices comply with Part 
15 of the FCC rules. Operation is subject to the following  
two conditions: (1) This device may not cause harmful 
interference, and (2), this device must accept any interfer-
ence received, including interference that may cause 
undesired operation.



Em5 User’s Manual
Appendix C: Em5 CE Compliance

38

Appendix C: 
Em5 CE Compliance

Application of Council            89/336/EEC
Directive:

Standards to which                  EN61326 : 1998
conformity is declared:            EN55022 : 1998

Manufacturer’s Name: Decagon Devices, Inc.                                   

Type of Equipment:              Data collection system.

Model Number: Em5

Year of First Manufacture:      2002

This is to certify that the Em5, manufactured by Decagon
Devices, Inc., a corporation based in Pullman, Washing-
ton, USA meets or exceeds the standards for CE compli-
ance as per the Council Directives noted above. All
instruments are built at the factory at Decagon and perti-
nent testing documentation is freely available for verifica-
tion.
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Appendix D: Em5R and Rm1
CE Compliance

Application of Council            89/336/EEC
Directive:

Standards to which                  EN 300 826, EN 60950
conformity is declared:           

Manufacturer’s Name: Decagon Devices, Inc.                                   

Type of Equipment:              Radio-enabled data collection
system

Model Numbers: Em5R, Rm1

Year of First Manufacture:      2002

Restrictions:
France: Current regulations in France stipulate that these
devices may be used indoors only. Outdoor usage on pri-
vate property is subject to authorization from the French
Telecommunications Regulatory Authority. Outdoor
usage on public lands is currently prohibited. For more
information see http://www.ero.dk.
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Appendix E: ECH2O soil 
moisture probes

The most common use for the Em5 is monitoring soil
moisture using Decagon’s ECH2O probes. This appendix
is a description of the specifications and operation of the
ECH2O probes.

ECH2O Specifications
Measurement Time: 10ms (milliseconds)
Accuracy: 

• Typically ± .03 m/m (±3%)

• With soil-specific calibration ±.01 m/m (±1%)

Resolution:

• 0.002m3/m3 (0.1%)

Power: 
• Requirements: 2.0VDC @ 2mA to 5VDC @ 7mA

• Output: 10-40% of excitation voltage (250-
1000mV at 2500mV excitation)

Operating Environment: 0 to 50°C
Range of Measurement:
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0 to saturated volumetric water content
Probe dimensions: 
(model EC-20): 25.4cm x 3.17cm x .15cm  
(model EC-10): 14.5cm x 3.17cm x .15cm 
Cable length: 10ft standard, extension cable available
Connector type: 3.5 mm plug 

Warranty Information
The ECH2O has a 30-day satisfaction guarantee and a 
one-year warranty.

About the ECH2O 
The ECH2O probe measures the dielectric constant of the 
soil in order to find its volumetric water content. Since the 
dielectric constant of water is much higher than that of air 
or soil minerals, the dielectric constant of the soil is a sen-
sitive measure of water content. The ECH2O probe has a 
very low power requirement and high resolution. This 
gives you the ability to make as many measurements as 
you want (even hourly) over a long period of time (like a 
growing season, for example), with minimal battery usage.



Em5 User’s Manual
Appendix E: ECHO soil moisture probes

42

Features

Fig.1: ECH2O probe diagram

Wiring Diagram

3.5mm plug wiring
The ECH2O probe comes with a 3.5mm “stereo-plug” 
style connector. This allows for rapid connection directly 
to Decagon’s Em5 or ECH2O Check. Below is a diagram 
showing the wiring configuration for this connector.

Circuitry

Sensor
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Fig. 2: ECH2O plug wiring configuration

Installing the ECH2O Probe
When selecting a site for installation, it is important to 
remember that the soil adjacent to the probe surface has 
the strongest influence on the probe reading and that the 
probe measures the volumetric water content. Therefore any 
air gaps or excessive soil compaction around the probe 
can profoundly influence the readings. Also, do not install 
the probes adjacent to large metal objects such as metal 
poles or stakes. This can attenuate the probe’s electromag-
netic field and adversely affect output readings.

Procedure
When installing the ECH2O probe, it is best to maximize 
contact between the probe and the soil. There are two 
methods to accomplish this:

1. Use Decagon’s Probe Installation Kit to install the 
probe. This kit has a custom-shaped blade to make the 
insertion in the soil, then another tool to place the 
probe into the insertion. For deeper installations, use 
an augur to reach the desired depth, then use the 
Installation kit with extension rods to install the probe.

Analog 
out

Ground Excitation
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2. Use a thin implement like a trenching shovel, garden-
ing spade, or flat bar to make a pilot hole in the soil. 
Then insert the probe into the hole, making sure the 
entire length of the probe is covered. Finally, insert the 
shovel again into the soil a few inches away from the 
probe, and gently force soil toward the probe to pro-
vide good contact between the probe and the soil. For 
deeper installation, excavate down to the level you 
wish to measure, then install the probe as described.

Orientation
The probe can be oriented in any direction. However, ori-
enting the flat side perpendicular to the surface of the soil 
will minimize effects on downward water movement.
Removing the Probe
When removing the probe from the soil, do not pull it 
out of the soil by the cable! Doing so may break internal 
connections and make the probe unusable.

ECH2O Probe Calibration
The ECH2O probes come pre-calibrated for most soil 
types. If, however, your soil type has high sand or salt con-
tent, the standard calibration will not be accurate. In such 
cases, you can perform specific calibrations for your indi-
vidual soil types. The standard calibration for the standard 
25cm length (EC-20) ECH2O probes when used with an 
Em5 is 

 θ (m3/m3) = 0.000424 * raw - 0.29

and for the shorter (model EC-10) probes is:

 θ (m3/m3) = 0.000571 * raw - 0.376
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where θ is the volumetric water content and “raw” is the 
raw data output. NOTE!: This calibration is only for 
use with Em5 data loggers.

Extension cables
Decagon supplies 50-foot (15.25m) and 10-foot (3m) 
extension cables for use with the ECH2O probe. You can 
safely connect up to 3 of the 50-foot cables without signal 
attenuation. For most applications, we recommend sealing 
the connections from the elements to maintain a good 
connection and to prevent corrosion. Decagon provides  
adhesive-lined heat-shrink for this purpose. To seal a con-
nection between two extension cables using the heat-
shrink, simply ensure that the heatshrink is covering the 
connection, then heat it using a heat-gun, blow-dryer or a 
lighter until it shrinks tight to the connection. Note: If 
using a lighter, place the heat-shrink well above the 
flame to avoid melting the heat shrink and the con-
nector. Additional heat shrink is available from Decagon.

Troubleshooting the ECH2O probe
If you encounter problems with the ECH2O probe, they 
most likely will manifest themselves in the form of incor-
rect or erroneous readings. Before contacting Decagon 
about the sensor, do the following:

• Check to make sure the connections to the data 
logger are both correct and secure.

• Ensure that your data logger’s batteries are not 
dead or weakened.
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If you encounter problems that aren’t due to the Em5, 
please contact Decagon at (509) 332-2756 and at 
echo@decagon.com.
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Appendix F: Other Sensors

ECHO Temperature Sensor
The ECHO Temperature sensor is available for use in soil 
or in the air. It can be connected directly to any channel in 
the Em5 or Em5R for long-term monitoring of tempera-
ture. 

Specifications:
Sensor Dimensions: 6mm diameter x 375mm long
Cable length: 3.05m
Temp. Range: -20 °C to 60 °C
Accuracy: ±0.5 °C
Resolution: 0.1 °C 

If you are using the ECHO Temp sensor in air, we 
strongly recommend that you use it in a radiation shield. A 
good type for this kind of sensor is available from Davis 
Instruments, Model 7714. 

ECH2O Rain Gauge
The Echo Rain Gauge is a self-emptying and frostproof 
electronic rain gauge that can be connected to your Em5. 
The ECHO Rain Gauge is made of durable weatherproof 
plastic and can withstand temperatures from below freez-
ing to extreme heat, and has an accuracy of ± 2%.
The rain is collected by the funnel and runs into a self-
emptying spoon, which automatically tips and is emptied 
when it is reaches a volume of five millimeters of water 
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(which corresponds to 1ml of precipitation). Each time 
the spoon empties, a measurement is sent and recorded by 
the Em5. Exported data will be displayed in terms of mil-
limeters of precipitation.

Drain Gauge
Decagon’s Drain Gauge is an instrument that is designed 
for long-term monitoring of water movement and chemi-
cal leaching below the root zone. Water filters through a 
soil column and collects in a sampling reservoir. The water 
fills the height of the reservoir, and the water level is mon-
itored by a an electronic water level gauge. When the water 
level reaches the top of the siphon tube, the water empties 
and the change in water volume is recorded by the Em5. 
The emptied water then drains into the sampling reservoir.
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Echolink 13
Em5

configuring 7
data capacity 36
data logging method 4
installation 7
range 9
setting time and date 25
specifications 36
system 3
weather resistance 7

Em5 name 15
email 1
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erase Em5 24
export

data format 22
files 21
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extension cables 45
F

fax number 1
FCC compliance 2, 37
file

menu 21
H

help menu 26
I

initialize radio 25
interference

between Em5Rs 10
from external sources 9

M
measurement interval

programming 15
measurement range 40
memory

capacity 36
type 36

N
no radio mode 16

P
plug

wiring configuration 42
power

requirements 40
Power Noise Filter 16
preferences

editing 23
R

Radio mode
setting 16
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radio module
removing from Em5R 29

radio settings 10
radio signal strength indicator 13
range 40

radio range 9
reset device 25
RF

interference 9
Rm1

configuring 11
Rm1 radio receiver

specifications 37
Rm1 setup 26
RSSI 13

S
scan 20
scan ports 20
seller’s liability 1
sensors

applicable for Em5 10
Set Time 16
setup menu 15
software utility 13
specifications 1, 40

Em5 and Em5R 36
Rm1 radio receiver 37

T
telemetry test 25
telephone number 1
terminal mode

using 30
time
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